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Section : General Knowledge

Q.1 The epithet 'Bliss-Giving Goddess' is traditionally associated with which of the

following Himalayan peaks?
Ans x 1. Mount Everest
x 2. Kanchenjunga
« 3. Nanda Devi
x 4. Annapurna
Q.2 What is the primary purpose of the SAHYOG portal launched under the IT Act,
20007

Ans x 1. To promote digital literacy among rural youth

« 2. To automate the process of sending notices for removal of unlawful online content
x 3. To facilitate automated income tax assessments

x 4. To support grievance redressal related to telecom services

Q.3 The Union Cabinet on 5 January 2024 approved the overarching scheme, s

of the Ministry of Earth Sciences for implementation during the period 2021-26

at an overall cost of ¥4,797 crore.
Ans 1. PRITHVI
x 2. JAL
x 3. AKASH

x 4. VAYU

Q.4 To which of the following was the Swaran Singh Committee related?
Ans x 1. Directive Principles of State Policy

« 2. Fundamental Duties

x 3. Fundamental Rights

x 4. Citizenship
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Q.5 Which team was the runner-up of Pro-Kabaddi League Season 10?

Ans 1. Haryana Steelers
X 2. Jaipur Pink Panthers
X 3. Patna Pirates

X 4. Puneri Paltan

Q.6 Which of the following countries won the U-19 Cricket World Cup 20247
Ans  x 1. India
X 2. Bangladesh
X 3. Ppakistan
v 4. Australia
Q.7 Through the 42nd Constitutional Amendment Act, how many fundamental duties
were added in the Constitution of India?
Ans x 1.9
x 2.1
¢ 3.10

x4.8

Q.8 Who among the following Sultanate rulers assumed the title of Sikandar Ae Sani?
Ans x 1.Balban

« 2. Alauddin Khilji

% 3. Mohammad Bin Tughlaq

x 4. Sikandar Lodi

Q.9 In reference to the physiographic divisions of India, what is the Northern Circar?
Ans 1. Coastal plains

x 2. Island

x 3. Waterfalls

x 4. River valley



https://applink.adda247.com/d/XhqWf9lSap
https://applink.adda247.com/d/XhqWf9lSap

Adda247

Q.10 On 13 August 2024, which of the following ministers launched the Jiyo Parsi
scheme portal?

Ans x 1.Raj Nath Singh
« 2. Kiren Rijiju
x 3. )Jagat Prakash Nadda

x 4. Nitin Jairam Gadkari

Q.11 Who among the following started the Indian Social Conference along with

Raghunath Rao as a subsidiary organ of the Congress during its third session in
Madras in 18877

Ans x 1.Raja Ram Mohan Roy
x 2. Mahatma Gandhi
x 3. Keshab Chandra Sen
« 4. MG Ranade

Q.12 Which of the following statements are correct with respect to the history of
India?

(1) The Dutch founded their first factory in Masaulipatam in Andhra Pradesh in
1605.

(2) Alfonso de Albuquerque captured Goa from the Bijapur Sultanate.

(3) The British East India Company established a factory in Madras in 1639 on

land leased from representatives of the Vijayanagara Empire called the Nayakas.
Ans x1.0nly2and3

% 2.0nly Tand 3
% 3.0nly 1and 2

«4.1,2and 3

Q13 In___ . Gandhiji gave a call for a satyagraha against the Rowlatt Act.

Ans X1 1923
X2 1921
¢ 3. 1919

x4 1917
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Q.14 How many questions were asked in the Census of India 2011?
Ans x1.15

v 2.29

x3.32

x 4.25

Q.15 Which of the following statements are correct as per the 2011 Census of India?

1. Approximately 79.8% of India's population identifies as Hindu.
2. The Muslim population in India is around 14.2% of the total population.

3. The highest population of Christians in India is in Tamil Nadu.

Ans 1.0nly Tand2

x2.0nly1and 3

% 3.0nly 2and 3

x4.1,2and 3
Q.16 Who is the president of the Paris 2024 Board of Directors, which is responsible

for overseeing the organising committee of the Olympic and Paralympic Games?

Ans x 1. Sebastien Coe

x 2. Thomas Bach

x 3. Gianni Infantino

« 4. Tony Estanguet

Q.17 Which of the following Parts of the Indian Constitution mentions certain

fundamental duties of the people?
Ans x 1. Partlll
x 2. Part |
x 3. Partll

« 4. Part IVA
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Q.18 What was the emblem of the Chola dynasty?
Ans x 1. Peacock

x 2. Elephant

« 3. Tiger

x 4. Crocodile

Q.19 Who was the first Supreme Court judge in India against whom an impeachment

motion was tabled in the Parliament?
Ans 1. Justice YV Chandrachud
« 2. Justice V Ramaswami
x 3. Justice JS Verma

x 4. Justice AM Ahmadi

Q.20 As per the 2011 Census of India, in which two states were female literacy rates

higher than the other states of India?
Ans x 1. Gujarat and Maharashtra
¥ 2. Haryana and Punjab
x 3. Tamil Nadu and Andhra Pradesh

« 4. Kerala and Mizoram

Section : Logical Reasoning

Q.21 If 2 is added to each odd digit and 1 is subtracted from each even digit in the
number 2781645, what will be the sum of the digits that are third from the left

and third from the right in the new number thus formed?
Ans x1.10
v2. 12
x3.14

x4.8
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Q.22 Refer to the following letter series and answer the question.
(Left)y TBYMRESICXZOWAQDFHGU K (Right)

How many consonants in the series are immediately preceded by a vowel?

Ans 1 Five
x 2.Seven
x 3. Four

x 4. Three

Q.23 DB 5 is related to JH 8 in a certain way. In the same way, GE 11 is related to MK14.
To which of the following is CA 36 related, following the same logic?

Ans x1.1H 39
x 2.]G 41
v 3.1G 39

x 4. JH 41

Q.24 What should come in place of the question mark (?) in the given series?

35, 43,59, 83, 115, ?
Ans x1.156

x 2.157

« 3. 155

x 4.154

Q.25 Each vowel in the word COMPANY is changed to the letter following it in the
English alphabetical order and each consonant is changed to the letter preceding
it in the English alphabetical order. Which of the following letters will be fourth

from the right in the new group of letters thus formed?

Ans x1.T

v2.0
x3.G

x4.P
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Q.26 106 is related to 134 following a certain logic. Following the same logic, 84 is

Ans

0.27

Ans

Ans

related to 112. To which of the given options is 229 related, following the same

logic?

(NOTE: Operations should be performed on the whole numbers, without breaking
down the numbers into their constituent digits. E.g. 13 — Operations on 13 such
as adding/subtracting/multiplying to 13 can be performed. Breaking down 13 into

1 and 3 and then performing mathematical operations on 1 and 3 is not allowed.)

x 1.202
x 2.258
v 3.257

x4.201

In a certain code language,
'A » B' means 'A is sister of B'
'A # B' means 'A is mother of B'

'A § B' means 'A is father of B',

Based on the above, how is P related to W, if X #PS Q x R#W?

¥ 1. Father
X 2. Mother’s mother
« 3. Mother’s father

X 4. son

Q.28 Select the pair that follows the same pattern as that followed by the two set of

pairs given below. Both pairs follow the same pattern.

FPZ : MWG
ZEP : GLW

x 1. DEF: 1M
X 2. TUV: FBC
¢ 3. PIN: WPU

X 4. coT: Ve

GET IT ON
Google Play
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Q.29 A paper is folded and cut as shown below. How will it appear when unfolded?

immediate right of G?
Ans x 1.N
v 2. P
%x 3.5

x4.F

]
B el e
I 11 I
Ans 1. O O
| = =
> —=>
O O
210 O
L |I<e =
<= =
O O
3.0 O
L | <= <=
<= <=
O O
4, OO
L= <=
= <4
O O

Q.30 S,P,D, F, G and N are sitting around a circular table facing the centre. Exactly
two people sit between S and N when counted from the right of N. G sits to the
immediate right of S. D sits to the immediate left of F. Who is sitting to the

GET IT ON
Google Play
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Q.31 Three of the following four word-pairs are alike in a certain way and thus form a
group. Which word-pair DOES NOT belong to that group?
(The words must be considered as meaningful English words and must not be
related to each other based on the number of letters/number of

consonants/vowels in the word.)
Ans x 1.Duck - Duckling
« 2. Horse - Cub
3. Squirrel - Kit

x 4. Polar Bear - Cub

Q.32 Based on the English alphabetical order, three of the following four letter-
clusters are alike in a certain way and thus form a group. Which letter-cluster
DOES NOT belong to that group?

(Note: The odd one out is not based on the number of consonants/vowels or their

position in the letter-cluster.)
Ans x 1.EDG
¢ 2. KKM
x 3. TSV
x 4. JIL
Q.33 CARD is related to IWFH in a certain way based on the English alphabetical order.

In the same way, ABRUPT is related to YUZWGF. To which of the given options is
DIGITAL related, following the same logic?

Ans 1. QFYNLNI
X 2. QEYNLNI
X 3. QFYNLNH
X 4. QFYMLNI
Q.34 What will come in place of the question mark (?) in the following equation if ‘+’

and ‘-’ are interchanged and ‘x’ and ‘<’ are interchanged?
26x2-4+7+6=2?

Ans x1.41
x 2.37
x3.28

v 4.35
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Q.35 Refer to the following letter series and answer the question that follows.

Counting to be done from left to right only.
(Lefty OFDEFFUOWBIAGKUVMVUIS (Right)

How many such vowels are there each of which is immediately preceded by a

consonant and also immediately followed by a consonant?
Ans x 1.None
x 2.0ne
x 3. Three

« 4. Two

Q.36 Select the set in which the numbers are related in the same way as are the

numbers of the following sets.

(NOTE: Operations should be performed on the whole numbers, without breaking
down the numbers into their constituent digits. E.g. 13 — Operations on 13 such
as adding / subtracting / multiplying to 13 can be performed. Breaking down 13
into 1 and 3 and then performing mathematical operations on 1 and 3 is not

allowed.)

(15,26,70)
(17,23,69)

Ans x1.(19,23,67)
« 2. (35,5,69)
x 3.(23,19,69)

x 4. (2711,71)
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Q.37 Six people, A, B, C, D, E and F, sit around a circular table facing towards the centre

(not necessarily in the same order). E sits second to the left of A. D is an
immediate neighbour of both B and A. C sits to the immediate right of B. Who sits
to the immediate left of F?

Ans x1.D
& 2. E
x3.B

x4.C

Q.38 Each of the digits in the number 3274861 is arranged in ascending order from
left to right. The position(s) of how many digits will remain unchanged as

compared to that in the original number?
Ans x 1.Three
x 2. None
x 3.0ne

« 4. Two

Q.39 What should come in place of the question mark (?) in the given series?

26, 226, 626, 1226, 2026, ?
Ans x1.2826
x 2.2926
x 3.3126
v 4.3026
Q.40 Each vowel in the word JUMPING is changed to the second letter following it in
the English alphabetical order and each consonant is changed to the letter

immediately preceding it in the English alphabetical order. How many letters will

appear exactly twice in the letter-cluster thus formed?

Ans x 1.0ne

x 2. Two
« 3. Zero

x 4. Three

Section : General English and Comprehension
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Q.41 Select the most appropriate option to fill in the blank.

Sheworea  dress to the party.
Ans x 1. milky
« 2. red
x 3. utile

x 4. joyous

Q.42 Select the option that can be used as a one-word substitute for the underlined

group of words.

There were lots of things we love about internet search, and it gives people

information and their time back because this is better, faster and more

productive of desired effects

Ans 1 efficient
x 2. absorptive
x 3. exulting
x 4. itinerant
Q.43 Select the most appropriate option to fill in the blank.
He is studying hard __ he can pass the exam.
Ans 1. sothat
x 2. therefore
x 3. because

x 4. otherwise

Q.44 Select the most appropriate meaning of the given idiom.

Drink like a fish
Ans x 1.0ne who is an important person but on an insignificant scale
x 2. A matter or a situation that needs to be dealt with
« 3. When one tends to consume large quantity of alcoholic beverages

x 4. 0ne who is an important person in a small group
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Q.45 Select the most appropriate ANTONYM of the given word.

Prolix
Ans x 1. Melodic
« 2. Concise
x 3. Fragrant

x 4. Rigid

Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 46

Q.46 According to the passage, at what age do children typically begin to show

contagious yawning behaviour?
Ans x 1. During teenage years
x 2. After age six
x 3. Around age two

« 4. Around age four
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.
SubQuestion No : 47
Q.47 Which of the following would be the most appropriate title for the passage?
Ans x 1.How to Stop Contagious Yawning in Public
« 2. The Surprising Link Between Yawning and Empathy
x 3. New Techniques for Teaching Autistic Children to Yawn

% 4. Yawning and Sleep Patterns in Children
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 48
Q.48 How is the passage structured?
Ans x 1. A debate between two opposing views on yawning
x 2. A fictional story followed by a list of symptoms
« 3. A cause-effect explanation supported by a personal anecdote and scientific study

x 4. A sequence of unrelated facts about yawning
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 49

Q.49 What can be inferred about the role of yawning in human interaction, based on

the passage?
Ans 1. Yawning might be an unconscious tool for emotional connection.
% 2. Yawning is purely a physical response to lack of oxygen.
x 3. Yawning serves no social purpose in humans.

% 4. Yawning is more frequent in children with autism.
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Comprehension:

Read the given passage and answer the questions that follow.

Watching someone yawn often makes you yawn too—even reading about yawning can
trigger it. A new study suggests that contagious yawning is linked to empathy and social
bonding. Children don’t typically develop this behaviour until around age four, and those
with autism are about half as likely to yawn in response to others. In severe cases, they
may never do so. This discovery could help doctors diagnose developmental disorders and
better understand subtle human connections. Molly Helt, a clinical psychology graduate
student at the University of Connecticut, was inspired by her autistic son, who didn’t yawn
back when she tried to help him clear his ears during a flight. “Autistic kids might be
missing that unconscious emotional link,” she said. Helt emphasised that understanding
others’ minds is a key part of human development—a trait autistic individuals often
struggle with. Yawning, she suggests, may reflect a deeper instinct for emotional

connection.

SubQuestion No : 50
Q.50 What is the central theme of the passage?
Ans 1. Yawning may be an indicator of empathy and social connection.
x 2. Contagious yawning is a way to cure autism.
x 3. Children under the age of four yawn more often than adults.

x 4. Yawning can be used as a teaching tool for children on airplanes.

Section : General Hindi and Comprehension
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Q.51 f&U I aTq &1 39gh AT fAAT0T & GIRT YT HIfFC |

qdl b ST

Ans x 1. 5gd-3Ed

x 2. Tra-Ard
x 3. I-98
v 4. dgd-dgd

Q.52 'Ua BT fqay A=t gm
Ans  x1.7B3]

X 2.PA

x 3. PIY

@ 4. AT

0.53 ffefad fasedl & & ‘WIa” &1 [AaiH g HI-371 82
Ans x1.a'q
@ 2.1
x 3.3
x 4. 39\
Q.54 HgIdaX & Hal 7Y BT T BI-
‘301¢ &1 &R T
Ans  x 1. AFUEE gl
2. 3= €6 Bl
X 3. HSTgd &l
X 4. FARATS B BT
0.55 "9’ & &R ¢l gid" cliaifte &1 31ef T & &-
Ans  x 1. 37990€ 3 S § 8T

x 2. 3T937¢l § Upid H IgI
» 3. 3TORTel & Tq1ey e g &l
x 4. T B A1 TR R & & 8
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Comprehension:
2 e DI YgHR YL IV G & IR Il
'THR U BT SARGI b YR Jdg a1 Higd ad &1 ¥ & HicIAfSd gdd-fAER 6 dvg 9 gARl
3! B FH1 S € 3R SRa g8 o 3R WiHd €1 7R Bid & g1 39 b uge Bl BIfer
B &, I 3N & G 7SR 37 @I &1 APB HBIR &H &1l &1 71d ¢, oft-soft Fu It R off
T DT &1 2 ST B FHIN & THSHT AR, R B B Wefardl Bt § e, HHuadT | §;
39 g5uTe H § S Ush-Udh BGH ol Ifd, Uh-Uh &9 Pl TeIs &I G oidl ¢l dIkdd § T¢Ts & Udd
BT G HY-3T9H & 21 H31 & 15 37! T BT BIg M el | 77 Siia & 0 @ 1 Ig fopaht
off 3raReT & 98 3199 T8 B Tl b 319 3P AT HIE 319 a1 78 38 78 !
SubQuestion No : 56
Q.56 33 A & ferv 3uyh ofifa I -
Ans 1. 9Id BT JE
X 2. U813 Bl Fgrs
X3 X PEX
x 4. died &1 gefA

Comprehension:
S e B UGHR I8 70 Ul & IR <IfIU :
THR U BT SARGI b Ye? Jdg bd Higsd aid &1 ¥ b HicIASd gdd-RIeER 6 dve 9 garl
3! & FH1 S € 3R SRa g8 O 3R Aiad €1 7R S & g4 39 fbe gga Bl BIfrer
B &, I3 & G 7SR 371 @I &1 APB ABWR &H &1 & 71d ¢, Hofi-soft Fu Iwar R off
T @Td 1 3 A1 Bl BHRI & THSHT A8, RN FH b Arfobdl Bl H e, SHOIAT H &;
39 g5uTe H § ST Ush-Udh BGH ol Ifd, Uh-Udh &9 bl TeIs Bl G oidl ¢l dIkdd H ¢Ts & Jdd
BT W HY-3T9H & g1 H3T & 13 37! et BT P15 I el | 77 S & 0 @ 1 Ig fopaht
ol 37991 & Ig AW &l BR bl b 379 3 foTU BIS 3MaIhdl el 38 IS &'
SubQuestion No : 57
Q.57 U¥dd e BT ST A9 & -
Ans x 1. I BI3 &I
o« 2. DI Ig4 BT 4RO
x 3. 99d frER &1 g9

X 4. BHAYA & 31 I IRuT
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Comprehension:
2 e DI YgHR YL IV G & IR Il
THIR U BT SARAI b Y Jdg a1 Higd ad &1 ¥ & HicIAfSd gdd-fAaR 6 dg d gARl
3! B FH1 S € 3R SRa g8 o 3R WiHd €1 7R Bid & g1 39 b uge Bl BIfer
B &, I 3N & G AR 371 @A &1 APB HBIR &H &1 &1 71d ¢, oft-soft Fu It R off
T DT &1 9 ST B FHIN & THSHT AR, R HH B Wefardl Bt § 8, HHuAdT X §;
39 g5uTe H § S Ush-Udh BGH ol Ifd, Uh-Uh &9 Pl TeIs &I G oidl ¢l dIkdd § T¢Ts & Udd
BT W HY-3T9H & g1 H31 & 13 37! it BT D15 I el | 77 Siia & 01 @ 1 Ig fopaht
off 3raReT & 98 3199 T8 B Tl b 319 3P AT HIE 319 a1 78 38 78 !
SubQuestion No : 58
Q.58 U¥dd e ¥ 'gd1el A &I A @ -
Ans 1. 3721 T &Ro1 &
X 2. 3771 &1 9T A &1
v 3. R &

x 4. 379 &1 7R 7T

Comprehension:

2 e B UGHR g 70 Ul & IR dIfI
'THR U BT SARAI b Y Jdg fbd Higs aid &1 ¥ P HicIASd gdd-fAaR & dvg 9 gARl
3! & FH1 S & 3R SR g8 HOH 3R AiHd &1 7R Bid1 & g4 37 b gge Bl BIfrer
B &, I3 & G 7SR 37 @I &1 APBI B &H &alel &l hd ¢, Hofi-oft Fu Jr R off
T T &1 2 ST 1 HHINT & THST TR, e ¥ BT Aefepdl Bt H A&, ol | §;
39 g5uTe H § ST Ush-Ueh BGH ol IIfd, Uh-Udh &9 bl TeIs &l G oidl ¢l dIRdd H T¢Ts & 9dd
BT W HY-3T9H & g1 H3T & 13 37! it BT I I el | 77 S & 0 @ 1 Ig fopaht
ol 37991 & Ig HIHT &l BR bl b 379 3 b foIU BIS 3TaIhdl 8l 38 IS &'
SubQuestion No : 59

Q.59 U¥dd il b W & -

Ans 1. HIdlHP
x 2. AT
X 3. PIATHD

x 4. faQuuras
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Comprehension:

2 e B UgHR I8 70 Ul & IR AT

'THR U BT SARAI b YR Jdg a1 Higd aid &1 ¥ b HicIAfSd ydd-fAER 6 dvg d gARl
3! B FH1 S € 3R SRa g8 o 3R WiHd €1 7R Bid & g1 39 b uge Bl BIfer
BV 8, 3 31 & Q¥ AR A Id &1 APB 3BER §H &Il &1 311 &, Bfl-Hl U Il IR ot
Tl @Td &1 2 AT Bl AR & FHSHT R, F1fP 4 B Arefebdl Bl H 8!, SHUIAT 7 ¢;
39 g5uTe H § ST Ush-Uch bGH bl I1fd, Uh-Ub &9 Pl FgIe Bl 3G oidl &l dRdd H G¢Ts & Udd
BT G HY-3T9H & 21 H31 & 15 37! T BT BIg M el | 77 Siia & 0 @ 1 Ig fopaht
ol 37991 & Ig HJHT &l BR bl b 379 3 foIU BIS 3Tl 8l 38 IS &'

SubQuestion No : 60
0.60 U¥dd e ¥ ygd Wedufsa &1 A & -
Ans 1. Jigd & 39RT g3
x 2. died A et g3
x 3. e J & g3
x 4. e & Bl g3

Section : Basic Knowledge of Computer

Q.61 Which of the following is NOT a type of technique for providing computer

security?
Ans x 1. Authentication
« 2. Document verification
x 3. Cryptography
x 4. Authorisation
Q.62 If we want to begin a new line of text without starting a new paragraph in MS
Word, which key(s) is/are used?
Ans 1. Shift + Enter
x 2. Enter
x 3.Tab

x 4. Shift + Tab
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Q.63 What is the function of anintrusion Detection System (IDS)?
Ans 1. Detect and alert administrators about potential security breaches
x 2. Prevent data loss
x 3. Encrypt sensitive data

x 4. Manage network traffic

0.64 What is the full form of modem?

Ans  x 1. Modulator-Demultiplexer
¢ 2. Modulator-Demodulator
X 3. Multiplexer-Demultiplexer

XK 4. Multiplexer-Demodulator

Q.65 An email client can be used to:
Ans 1. send and receive emails

x 2. access the internet

x 3. edit MS Word documents

x 4. browse websites

Q.66 Which of the following allows a user to search for Clip Art directly within MS

PowerPoint?
Ans 1. Insert > Online Pictures
x 2. Design > Slide Size
% 3. Home > Find
x 4. View > Notes Page
Q.67 To send an email to someone who is not on the 'To' or 'Cc' list, which of the
following options must a user select?
Ans x 1.Reply
« 2. Forward
x 3. Resend

K 4. Reply All
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Q.68 When replying to a thread of emails, it is generally recommended to:
Ans x 1. delete the original message and start a new thread

¥ 2. quote the entire original message to provide context

x 3. reply to all recipients, regardless of their relevance

« 4. quote only the relevant parts of the original message

Q.69 Which option in MS Word allows users to create a list of predefined items that

users can insert into a document repeatedly without having to retype them each
time?

Ans x 1. AutoFormat
x 2. AutoCorrect
« 3. Quick Parts

x 4. AutoText
Q.70 Which of the following combinations is NOT correct?

Ans  x 1. Paste function = Ctrl+V keyboard shorteut
« 2. Undo function = Ctrl+U keyboard shortcut
X 3. Copy function = Ctrl+C keyboard shorteut

X 4. Cut function = Ctrl+X keyboard shortcut

0.71 Which of the following options is NOT present under the Format Background feature for filling colour in an MS
PowerPoint slide background?

Ans X 1. Texture fill
X 2. Gradient fill
X 3. solid fill
« 4. Image fill
Q.72 Which of the following options is NOT present under insert Date and Time in an
MS PowerPoint presentation?
Ans x 1. Language

x 2. Update automatically

« 3. Update by user

x 4. Fixed
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Q.73 How can one quickly create a sequence of numbers starting from 10 and

increasing by 5 using the Series dialog box in MS Excel 20107
Ans x 1. Select the cells > Right-click > Series
x 2. Data > Create Sequence > Step Value = 5, Starting Value = 10
« 3. Home > Fill > Series > Step Value = 5, Starting Value =10

x 4. Formulas > Create Series > Set increment to 5

Q.74 Which type of computer virus spreads through email attachments and infects

computers when opened?
Ans x 1. Logic Bomb
x 2. Worm
% 3. Trojan Horse

« 4. Macro Virus

Q.75 Which of the following items is NOT available in MS-Word?
Ans x 1. Italic
x 2. Bold
x 3. Underline
« 4. Magic tool
Q.76 When composing an email message, which of the following keyboard shortcuts is
used to insert a hyperlink into the message as an attachment?
Ans x1.Ctrl +|
x 2. Ctrl + Shift + 2
« 3. Ctrl + K

x 4. Ctrl +L
Q.77 Which of the following options is NOT a method to close a document in Microsoft Word?
Ans  x 1. Pressing Ctrl+W

X 2. Selecting ‘Close’ from the File menu

X 3. Clicking the Close button (X) at the top-right corner

« 4. Pressing Ctrl+C
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Q.78 What is the primary benefit of enabling two-factor authentication (2FA) on a

smartphone?
Ans 1. Additional security layer against unauthorised access
x 2. Increased password strength
x 3. Faster app performance

x 4. Improved battery life

Q.79 Which of the following functions is used to address a cell in another sheet in the

same workbook in MS Excel?
Ans x 1.Sheet address!Cell address
x 2. Sheet address!Cell column

x 3. Sheet row!Cell address

« 4. Sheet namelCell address

Q.80 Select the correct statement regarding Browser Hijacker (a computer virus)?
Ans 1. This virus attacks web browser security, enabling a hacker to inject web-pages with
malicious code or client-side scripting.
x 2. It can also contain adware that causes unwanted pop-ups and advertisements.

x 3. These are extremely dangerous because they can completely cripple entire computer

networks.

x 4. This is one of the most common computer viruses. It overwrites files when they are

opened and can quickly spread across systems and networks.
Q.81 The average of 6.5, 10.6, 19.7 and a is 13. The value of a is:
Ans x1.16.2
x2.172
v 3.15.2

x4.14.2
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Q.82 Find the value of y,satisfying 28 X 2 X 585 =+ V2025 = y + 703
Ans x1.24

x 2.16

¢ 3. 25

x 4.30

-

Q.83 The value of83—53+(%)é—7+4)(2=_
Ans »1.492

x 2.500

X 3.494

x 4. 495

Q.84 A scooterist travels at the speed of 42 km/hr for 3 hours and at the speed of 48

km/hr for 2 hours. Find the average speed (in km/hr) of the scooterist.
Ans x1.43.2
x 2.44.9
3. 44.4

x4.438

Q.85 The present age of Ramesh is three times the sum of the ages of his three
children. After 25 years, his age will be equal to the sum of ages of his children.

Find the present age of Ramesh.

Ans x 1.55years

x 2. 85 years
« 3. 75 years

x 4. 65 years

Q.86 In an election between two candidates, 95% of the registered voters cast their
vote and 20% of the votes polled were found invalid. The winning candidate got
55% of the valid votes and won the election by a margin of 1976 votes. How many

voters were registered?
Ans x 1.25997
v 2.26000
x 3.26001

x 4.26002
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Q.87 A can complete a work in 12 days and B in 16 days. If they work on it together for

3 days, then the amount of the work left is:
Ans x 1. A
48

x 2. 2
48

32
16

Q.88 A boat’s speed in still water is 10 km/hr, while the river is flowing at a speed of 2
km/hr. The time taken to cover a certain distance upstream is 5 hours more than

time taken to cover the same distance downstream. Find the distance.
Ans x 1.110 km
« 2. 120 km
% 3.100 km

x 4.130 km

Q.89 Find the value of the given expression.

0.92 x0.92 - 0.08 x 0.08
Ans x 1.1

x 2.0.92

x 3.0.08

v4.0.84

Q.90 The age of Kalpana after 12 years from now will be 40 years. Jyoti is 7 years
younger than Kalpana. The ratio of the present ages of Jyoti and Chanchal is 3 : 5.

How old was Chanchal 10 years ago?
Ans x 1. 24 years

X 2.23 years

x 3. 26 years

& 4. 25 years
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Q.91 Neha saves y% of her income. If her income increases by 30% and the
y

expenditure increases by 25%, her savings increase by 40%. What is the value of

y? (Rounded up to two decimal places)
Ans x1.35.23

x 2.42.25

x 3.25.25

v 4.33.33

Q.92 The original price of a music set is ¥8,100. The price is discounted by 20% and
then raised by 25%. What is its new price (in ¥)?

Ans x1.7400
x 2.8,600
x 3.7,600

v 4.8,100

Q.93 The sum of five numbers is 655. The average of the first two numbers is 76 and

the third number is 113. Find the average of the remaining two numbers?

Ans x 1.196
x 2.190
% 3.189

v 4.195

Q.94 A merchant offers a discount of 40% on the list price, due to which she makes a

loss of 16%. What percentage of profit or loss will she make if she sells at a
discount of 20% of the list price?

Ans x1.10% profit
x 2.10% loss
x 3.12% loss

& 4.12% profit
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Q.95 In a chemical industry, there is a tank in which 2 chemicals, A and B, are mixed
together. The chemicals are supplied by 2 pipes which can fill the tank in 30 and
20 minutes, respectively. A third pipe carries the mixture from the tank at the
rate of 4 litres per minute. All the three pipes working together can fill the tank

in 15 minutes. The capacity of the tank (in litres) is:
Ans »1.240

x 2.420

x 3.120

x 4.360

Q.96 The selling price of 50 books is equal to the cost price of 34 books. Find the loss
or gain percentage.

Ans x 1. 100

% gain

x 2. 100

% loss
« 3.32% loss
X 4.32% gain
Q.97 Simplify V1014 + 96+ V54— /864

Ans X1 5.6
X2 10v6
X 3. 66
& 4. 86
Q.98 Deepak’s salary is first increased by 40%, then decreased by 35%, and again
increased by 25%. The net change in his salary will be:
Ans x1.a12.25% decrease
& 2.2 13.75% increase
x 3.an 11% increase

x 4.a13% decrease
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Q.99 The price of a chair is marked at ¥2,300. A shopkeeper earns a profit of 20%
after allowing a discount of 20% on the marked price. Find the cost of the chair

(correct to two decimal places).
Ans »1.31,533.33
x 2.31,633.00
x3.%1,733.40

x 4.31,453.50

Q.100 A shopkeeper owns a coffee shop. In February 2024, 5500 hot chocolates were
sold. The number of hot chocolates sold in March 2024 was 6% less. How many

hot chocolates were sold in March 20247
Ans x 1.5550
¢ 2.5170
x 3.5280

x 4.5720
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